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INTRODUCTION

Welcome to Millionaire, a captivating
adventure info the world of stock markef
investing. You are about fo experience the
thrill of high finance while learning basic stock
market ferms, skills, sfrategies, and concepts.

You will be entering a remarkable simulo-
tion of the real world, because Millionaire is
based on acfual stock market tfrends and
hisforical events, not just random numbers.

Af the beginning of each game, your
computer creates a new stock market envi-
ronment, just for you. No two environments
are ever exactly alike. Just like in real life.

The environment consists of 91 weeks of
stock market fluctuations. As you begin the
game, 13 weeks have passed. This provides a
history you may use fo begin plofting strafegies
as you start down the road to your fortune.

Before you order your Ferrari Turbo
Coupe and Lear Jet, however, there are a few
terms you must become familiar with.



WHAT IS A STOCK?

A piece of the action, one might say.

Or of a corporation, to be precise.

In order to raise money — working capital to
build factories, fund research, etc—a corpo-
ration sells shares. These shares are “'stock”
in the company. Individuals who purchase
sfock become part owners of the company.

How much of a company you own
depends not upon how many shares you buy;,
but upon the proportion of the number of
shares you own to the total number of shares
issued by the company. An investor who owns
100 shares of a company with 1,000,000
shares outstanding owns a smaller part of a
company than an investor who owns only 10
shares of a company with just 100 shares
outstanding.

Stock owners can usually resell their stock
through a stock exchange, which is simply a
place where representatives of the buyer and
seller — called brokers — meet and negotiate
prices. Stock prices are determined by several
facfors, including: the company’s current profits,
anticipated future profits, the value of assets
(factories, patents, real estate, etc.), and cash
on hand.

If a company’s prospects are optimistic,
then its stock will be in demand, and the price
will rise. Conversely, if prospects are dim, the
price will drop.

Why would you buy stock in a company?

Long-ferm investors hope to receive a
portion of the corporate profits, called divi-
dends. Furthermore, such investors hope that
the price of the stock will increase as the size of
the company grows. In real life, there are also
many fax incentives that help to promote
investing money in corporafions.

On the other hand, there are those who
look to malke a profit in a shorter period of

time. By hopping on the bandwagon of a
stock thaf has a rapid upward change in price
(for whatever reason), the investor makes a
substantial windfall profit. This is considered
speculafion.

In Millionaire, as in real life, speculators
are the ones who get rich quick. However,
speculators must accept much more risk than
the long-term investor is generally willing fo do.

FACTORS THAT INFLUENCE YOUR DECISION

In order fo minimize risks, a speculafor
looks af many factors to determine which way
a stock price will go. The following are some
of the facfors that influence the market:

1. The profitability of a corporation. Normally
announced every three months inan
earnings statement. Profits are referred
fo as earnings.

2. Changes in the number of shares traded
on the stock exchange. Sudden increases in
stock sales can signal a significant price
change is imminent. This may be due to
“insider tfrading” (shares sold by company
officials who may have a better understand-
ing of a company’s prospects than the
general publio), or large trades by
institutional investors, such as banks and
insurance companies.

3. News announcements about a company.

Information about new products, earnings
or potential problems can have a dramatic
effect on a company’s stock price, for
obvious reasons.

4. Stock price trends. Analyzing the stock price
fluctuations over fime can give clues to
future performance. History tends to repeat
itself.

5. Industry group trends. Looking af a single

industry can yield clues noft visible in a
single stock’s price fluctuations. Certain



factors will affect an entire industry, and this

will be reflected in the price of individual

corporate stocks.

EXAMPLE: A harsh winter storm immedi-
ately prior to the Christmas season will have a
dramatic effect on the retail industry, because
shoppers won't go to stores in poor weather.
This would affect most companies in the
retail industry group.

6. Stock market trends. The stock market
sometimes seems to have a life of its own
that can cause individual stock prices to
move illogically. The market goes through
cycles: when stoclk prices generally rise, it is
referred to as a "bull market!” When they
fall, a "bear market”’

In a bear market, for example, a com-
pany’s stock price may drop along with the
markef even though the company’s profits
—called earnings — are increasing.

7. The company history. Understanding a
company’s roofs can be helpful in identify-
ing unusual corporate moves that may
affect stock prices.

8. Daily stock price changes. Daily changes in
stock prices, new highs or lows, are the key
to many buy and sell decisions.

Once a speculator has analyzed all these
factors (no simple task, obviously, or we'd all
be rich), he looks for a stock that can be

expected to experience a rapid change in price.

(It need not be an upward change in price,
by the way, which will be explained later.)

Speculators sometfimes buy stock on credit.

This is called margin buying. In such a frans-
action, the buyer must normally make a down
payment of at least 50% of the value of the

stock, and the broker extends credit on balance.

If a stock purchased on margin goes down
rather than up, the broker may "call” the
margin. This forces the speculafor to come
up with enough money to return his equity
to the 50% level.

In Millionaire, @ margin call occurs when
the speculator’s equity drops below 30%. If the
speculator does not have enough cash fo
cover the margin call, then some or all of his
stocks will be sold by the broker. In Millionaire,
all of the margined stock will be sold if funds
do not exist to cover the margin call. The
obvious advantage of buying on margin is
that you pay only a porfion of the total price
and your broker extends credit on the balance.
In Millionaire, there is an 18% annual interest
charge on margin credit.

THE STOCK OPTION

Options are simply the right to buy or sell
shares of a stock (usually in lots of 100) at a
price agreed upon in advance. Options are
extended only for a limited period of fime,
and automatically decline in value as the
expirafion dafe for the option approaches.
An expired option is worfhless.

There are fwo types of options: "put”
options and “call” options. The call option is
the right fo purchase stock for a previously
agreed upon price. The puf option is the right
to sell stock for a previously agreed upon price.
The rise of a stock'’s price causes a call option
to increase in value. The decline of a stock's
price causes a put option fo increase in value.

EXAMPLE: In June, K-Marf stock is trading
for $50.00 a share. You pay $1.00 for each
$55.00 call option that expires in September.
In July, the price of K-Marf stock is unchanged,
but your option is now worth only $.70, as the
expiration dafe is one month closer. In August,
the price of K-Mart stock jumps to $60.00 a
share. As your options entitle you to buy
stock at $55.00, you could exercise your
option, buy K-Mart stock at $55.00, and resell
it for $60.00. Your profit would be $5.00 per
share, less the initial option price. In reality,
options are seldom exercised but are sold fo



other speculators. In this example, when K-Mart
jumped to $60.00, the price of the option
would have increased to around $5.50, and
could be sold for a profit of $4.50 per option
($5.50 sale price minus $1.00 purchase price).

EXAMPLE: In June, K-Mart is frading for
$50.00 per share. You pay $1.00 for each
$45.00 put option that expires in September.
If the price of K-Mart stock rises to $60.00 the
next day, the value of the option will drop to
around $.80, because the stock price is now
$15.00 away from the striking price ($45.00).
In August, the price of K-Mart stock drops fo
$35.00 per share, and your K-Mart options
jump to $10.50 per option. Savvy investor that
you are, you sell and pocket the hefty profit.

As these two examples illustrate, a call
option is purchased when you believe the
stock price will rise significantly. A put option is
purchased when you believe the price will fall
significantly.

Sometimes options are used for protection.
For example, if you purchase shares of Dow
Chemical at 120, you might purchase an
equal number of put options enabling you to
sell Dow Chemical at 100. This is “insurance”
that protects you against cafastrophic loss.

Options in Millionaire are best used for
speculation. If you believe a stock will rise or
fall dramatically, the lower price of options will
permit you fo “control” far more shares (and
potential profit) than if you bought the shares
outright. This is called leverage.

In speculative investing, you wish fo get
the most leverage possible. That is, fo control
as many shares of stock as possible given
your current resources. $100 worth of options
give you greater leverage than $100 worth
of stocks because you control more shares
(since options trade at a fraction of the price
of the stock). If a stock goes up by $10,
the profit per option share is the same, once

the striking price has been crossed. Because
the speculator controls more shares with
options, the fofal profit is much greater.

A shrewd speculator may reap huge
profits with relatively few personal resources
through leveraging. The more leveraged you
are, the greater the risk, of course. A small
downward price fluctuafion that would prove
a minor annoyance fo the owner of stock
may spell doom to the highly leveraged in-
vestor, collapsing what is basically a house
of cards.

BORROWING AGAINST YOUR NET WORTH

In some cases, a speculator can borrow
money from public and private sources using
his assets (including stock) as collateral. Loans
of up fo 80% of your net worth are possible.
Buying sfocks with money borrowed against
your assets and 50% margin can give you
tremendous leverage (and risk). Interest, of
course, must be paid on any loans as with
margin accounts.

SELLING SHORT

Another technique used by speculators is
called “selling short’ If a short seller believes
the price of a stock will fall dramatically, he
"borrows” the stock from another investor for
a fee. The speculator then sells the stock and
banks the receipts. When the stock falls in
price, he buys it on the open markef, and
returns if fo the original investor, pocketing
the difference in price as profit. The only
expense the short seller incurs is the fee paid
to borrow the stock. Of course, if the specu-
lafor's calculations are off, and the stock rises
in price, he must male up the difference when
replacing the stock. Short selling is very risky,
and is not a technique available to players
in Millionaire.



COMMISSIONS, TAXES AND
OTHER FACTS OF LIFE

When you buy or sell stock through a
broker, the broker takes a percentage of the
total fransaction as his commission. In Million-
aire, commission is 1.5% of the total transaction
value.

Nothing escapes the clutches of Uncle
Sam, and that goes for money made in the
stock marlket. How much tax depends on the
individual's tax bracket. In general, short-term
profits (from stocks held less than one year)
are taxed af twice the rate of long-term profits
(on stocks held at least one year). Losses re-
duce the tax burden by the same proportions.
In Millionaire, the tax rate is fixed at 30%.

If it were only that way in real life...

Stock holdings are called a portfolio. In
Millionaire, you will have three portfolios: one
each for stock, call options, and put options.

If you wish to learn more about the stock
market (the more you know, the better your
analysis will be), investigate “Your Investments”
available from any good bookseller. It is pub-
lished by Dun & Bradstreet, one of Wall Street's
most respected investment firms.

Although Millionaire uses concepts based
upon the actual stock market, there are many
subtle (and not so subtle) differences between
the simulafion and real life. If you plan to
invest in the market, you should investigate
books like the one mentioned above.

MILLIONAIRE GROUND RULES

The objective in Millionaire is fo earn
$1,000,000 as quickly as you can. To do this,
you must malke shrewd, timely investments
in stocks and options.

You start out with a Novice status and
$10,000 cash. As a Novice, you may buy or
sell stocks. You may not purchase stocks on
nmargin, or purchase options.

Net worth is the yardstick of success in
Millionaire. Your net worth is defined as the

sum of all your assets (cash, stocks, and
options), less your liabilities (loans, taxes, and
commission obligation).

As your net worth increases, your stafus
also rises; as your stafus rises, so will your
investment alfernatives. The screen below sets
forth the privileges of rank.

Privileges of Rank*

E[J=———— Status Reference

Net Investment
Worth Status Opportunities

10,000 Novice Buy stocks but not on margin.
12,000 Investor Buy stocks on margin.

18,000 Speculator Buy call options and stocks on margin.
40,000 Brofessional Buy call options, put options, and

stocks on margin.

All of the above and borrow up to 80

100,000 Broker percent of your net worth.

1,000,000 : Millionaire You did it!

2

*You may only advance one status level in a single week.
If you are a Novice who suddenly makes $100,000, you
must wait a few weeks to obtain Broker status.

EXAMPLE: When your net worth reaches
$12,000 or more, you become an Investor
and are able to buy stocks on margin. When
you reach $18,000, you can buy call options
as well as stocks on margin.

Once your status has risen to a certain
level, it will not be reduced even if your net
worth should drop below the required level.
For instance, if you become an Investor by
obtaining a nef worth of $12,000, a subse-
quent drop in net worth to $8,000 will not
reduce your status.

If your net worth drops below $1,000,
you will be declared bankrupt, your staftus will
drop to Novice, and you will be given $7.500.




When you reach Millionaire, you will be
given $50,000 and started out on a quest for
your next million dollars. The objective, once
you have become a Millionaire, is to find out
how quickly you can earn another $4,000,000.
Be careful not to go bankrupt and lose it all.

THE INVESTMENT ARENA

At the start of the simulation, the computer
creates a new stock market environment. You
begin in week 14 of a 91-week session. Each
week you have the opporfunity to buy and
sell stocks and options.

Stock prices change each weelk just as
they do on Wall Street. At week 91 assets are
converfed to cash and —along with your status
—are saved by the computer. You can then
begin a new session of 91 weelks using the
cash and stafus earned in the previous sessions.
With a little luck and a lot of skill, you will
become a Millionaire. But it will probably take
you several sessions to do so.

The Macintosh can store up fo 14 players’
data (end of session cash and stafus). If you
wish to stop a session before the 91st week,
you may store the complete game sfatus,
including the market environment, for later
recall.

The Millionaire stoclk markef consists of 15
sfocks in 5 industry groups. Each stoclk is indi-
cated on the main Millionaire screen by its
corporafe logo, as illustrated in the Logo Panel
screen fo the right. Each level of logos, moving
from top to bottom, represents an industry
group. The five groups are: computer, oil & gas,
retail, automotive, and heavy industry.

Logo Panel
S[J=———— Stock Reference
ey B8 |ogl  fem
Data
L e Y
sty el [ [y

Auts '. Bendix
Industry AmercaN U
H
s, G e  |[B

CAT

THE MOUSE THAT ROARS ON WALL STREET

Most of the time — probably 90% —you
need only manipulafe the mouse fo play
Millionaire. You will use the keyboard when
you are entering numbers or a player’'s name.

The basic action requires that you ma-
neuver the poinfer on the screen by moving the
mouse on a flat surface, such as your desk. The
pointer follows the movement of the mouse.
The pointer changes shape depending on what
you are doing. Usually it will be shaped like an
arrow. When the pointer is a wristwatch, the
Macinfosh is asking you to wait while it performs
some acfion.

The screen on the Macintosh is offen re-
ferred fo as the desktop, and the fwo will be
analagous in this document.




SELECTING MENU OPTIONS

Game actions are selected from the menu
bar at the top of the screen. The title of each
menu appears on the screen at all fimes. You
can scan the menu options available to you by
positioning the pointer on the menu bar, press-
ing the mouse buffon, and holding it down.
The title of the menu you are pointfing to will be
highlighted, and the menu will appear. Moving
the pointer to the left or right causes the menu
title fo the left or right to be highlighted and the
corresponding menu fo appear.

You choose a specific menu option by
moving the arrow up or down fo that opfion
and releasing the mouse button. As you drag
the pointer through a menu, each option
poinfed to will be highlighted. Nothing will be
selected until you release the mouse button. If
you change your mind about selecting some-
thing from the menu, simply move the pointer
away from the menu.

Some commands will appear dimmed in
the menu and will not become highlighted
when the arrow points fo them. These
commands are referred to as inactive and
cannoft be currently selected.

MANIPULATING WINDOWS

Information in Millionaire (graphs, tables,
descriptions) appears in rectangles that are
referred fo as windows. Windows are mani-
pulated with the mouse. They can be brought
to the front of the desk, moved on the desk,
made smaller or larger, or closed.

To bring a window to the front...Click
anywhere in the window. This is referred to as
activating the window, and the window is now
referred fo as the active window. Only one
window will be active at any given time.

To move a window... Posifion the pointer
in the fop bar of the window, press the mouse
bufton, and hold the mouse button while mov-
ing the mouse. On the desktop, a dotted out-
line of the window will follow the movement
of the mouse. When the outline is positioned
where you wish the window to appear, release
the mouse bufton. The window will be redrawn
af this new locafion, and it will now be the
active window. (To cancel the move, drag
the pointer into the menu bar. A window can't
be moved off the top of the desk.)

To change the size of a window...Bring
the window fo the front. Position the pointer in
the box at the bottom right corner of the
window. This is referred to as the size box. Press
the mouse button and hold it while moving the
mouse. A dofted outline of the window will
follow the movement of the mouse. When the
outline is positioned where you wish the win-
dow fto appear, release the mouse button. The
window will be redrawn to fit the new dimen-
sions. (To cancel the resizing, move the mouse
so that the dotted outline is the same as the
original outline of the window.)

To close a window...Bring the window to
the front. Position the pointer in the box af the
top left corner of the window:. This is referred to
as the close box. Click the mouse button. The
window will disappear from the desktop.

COMMUNICATING WITH THE MACINTOSH

Throughout Millionaire, it will be necessary
for the Macintosh to provide you with informa-
tion and to obtain information from you. This
communication will occur in special windows
which are referred to as dialog boxes. Through
dialog boxes, you will asked to enter a player’s
name, to enter dollar amounts for the various
transactions in Millionaire, and fo confirm acfions
that will permanently alter the outcome of the



session. The Macintosh will rely on dialog boxes
to tell you when you have requested an action
that it doesn't understand or can't implement.
Pictures, some help information, and fransaction
reports will also appear in dialog boxes.

Case #1...In the case when the Macintosh
is providing you with information, the required
response is to move the pointer to the “Con-
tinue” button and click the mouse button. The
dialog box will disappear and the desktop will
appear as before.

Case #2...In the case where you are being
asked fo confirm an action, your response will
be to move the pointer to the butfon you wish
to select and to click the mouse button. For
example, when you ask the Macintosh to delete
a player from the player directory, the Macintosh
will respond by asking you to confirm the
deletion. Two buttons will appear: "Delete” and
"Cancel If you select "Delete,’ the player will
be deleted; "Cancel” will allow you a clean
escape from the deletion process. In both cases,
the dialog box will disappear and the desktop
will appear as before.

Whenever a "Cancel” button appears in a
dialog box, it can be used to escape from the
action in progress. When an "OK" button
appears, if can be used to further the acfion
being carried out, analagous to the "Delete”
button in the example above.

Case #3...The third case is one in which
you will be asked to enter specific information.
In Millionaire, there are only two types of
information that will be requested. The most
common fype will be fext, i.e. the entering of
numbers or characters. Simply type in your
enfry. The text will appear in the designated
rectangle within the dialog box.

The second type will require the selection
of one ifem from several. The choices will
consist of a list of items with a circle in front of

each item. Simply click on your choice. The one
which is selected will be indicated with a doft in
the circle preceding it.

When you are finished entering information
in the dialog box, click on one of the buttons as
mentioned in Case #2.

Notes on Dialog Boxes...With the excep-
tion of those for buying, selling, and borrowing,
dialog boxes in Millionaire require you fo
respond fo them before you can do anything
else. In other words, you will be unable to
select menu items, manipulafte windows, efc.,
until you are finished with the dialog box.

A dialog box must be the active window
in order for it to accept input. If you are entering
text and nothing is happening, if is because the
dialog box isn't active. Click on the dialog box
and then proceed to enter the fext.

Often one of the buttons in a dialog box
will appear boldly outlined. This button is re-
ferred fo as the defaulf button; it is the button
which is most commmonly selected. If you enter
“"Refurn” or “Enter” from the keyboard, the
dialog box will be processed as if you selected
the defaulf button.

Somefimes a button in a dialog box will
be dimmed. This indicates that it can't be
selecfed yet. For example, in a dialog box thaf
asks for a dollar amount, "OK" is dimmed until
you enter the amount because the transaction
can't be processed until the amount is enfered.

PREPARING TO PLAY

Turn the Macintosh on. You will see a small
picture (referred to as an icon) of a Macintosh
disk on the screen. The blinking question mark
within the disk is the Macinfosh’s way of asking
you to insert a disk. Insert the Millionaire disk,
metal end first with the label facing up, info the
disk drive. Millionaire will start automatically.
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Player Directory Screen

" & File Edit Play

Millionaire

Add a new player to the
player directory ...

Choose 'Add player’ from the Edit
menu. Enter the name of the new
player & select the status desired
Start a new game ...

Click on your name in the player
directory. Choose ‘New game’
from the Play menu

Resume a saved game ...
Click on your saved game in the
player directory. Choose 'Saved
game’ from the Play menu.

Delete player(s) from the
player directory ...

Click on the player to be deleted in
the player directory. (Or select
more than one player by clicking on
the first one & dragging the mouse
down to the last one.) Choose
‘Delete player’ from the Edit menu.

If, when you insert the Millionaire disk, the
desktop contains icons other than the empty
disk icon, Millionaire will not start automatically.
Instead, icons related to the Millionaire disk will
appear on the deskfop. This being the case,
move the tip of the pointer onfo the icon
entitled "Millionaire;” and click the mouse button.
The “Millionaire” icon will become highlighted.
(This is the standard way in which you will
select icons on the Macintosh.) Choose "Open”
from the "File” menu. Millionaire will now start.

The first window that will appear is the title
window. After a moment you will see the win-
dow shown above. On the left are instructions
that will guide you in preparing for a session.
On the right is the player directory:. If this is your
first fime playing Millionaire, you will begin
by adding your name to the player directory.

To add a new player...Choose "Add
Player” from the "Edit” menu. The "Add New

Player Directory

Last |  High
Score i . Score

Player” dialog box (shown below) will appear
on the left side of the desktop. Enfter your name
(5 letters maximum; you may have to abbre-
viate), and select the status at which you wish

New Player Dialog Box

ADD NEW PLAYER

]

Status of player:
@® Novice

O Investor

O Speculator

(O Professional
O Broker

(_sx ] [cancel)




to begin. The default stafus is Novice. To properly
learn the various investment opporfunities
available fo you, it is highly recommended
that you do not override this defaulf during
your first few times playing Millionaire. Selecf
"OK! Your name will be added to the player
directory, and will appear highlighted.

To begin a new session or resume a saved
session...First, you need to let the Macintosh
know which player you are. To do so, click on
your name in the player directory. This will
cause your name to become highlighted. From
the "Play” menu, select "New Game” to begin
a new session or "Saved Game” fo resume a
session already in progress. If you haven't saved
a game during a previous session, "Saved
Game” will be dimmed in the menu.

To delete a player or players...First, high-
light the player(s) you wish to delete. If you
wish to delete one player, click on that player in
the player directory. If you wish to delete more
than one player and they appear consecutively
in the player directory, click on the first player
and, while holding the mouse button down,
drag the pointer down to the last one. They will
all appear highlighted. If you drag the pointer
too far, simply drag it up again. (If you wish
to delete players that aren't consecutive in the
player directory, then you must delete them
one by one.)

Select "Delete Player” from the "Edit” menu.
A dialog box will appear in which you will be
asked to confirm the deletion. Refer to "Case
#2" in "Communicating with the Macintosh”
for a detailed explanation of this dialog box.

TRADING BEGINS

You enter a session at week 14. Three
windows appear on the desktop. Two of these
windows, a chart of corporate logos and a
status box, will be visible on the desktop most
of the time.

The Chart of Corporate Logos in the upper
left hand corner is fundamental fo the playing
of Millionaire. Whenever you wish to buy;, sell,
or research a specific company, you will use this
chart to tell the Macintosh which company you
are inferested in. To do so, move the fip of the
pointer onto the logo of the company of your
choice, and click the mouse button. The logo
will appear outlined in black. All menu options
that pertain fo a specific company will now be
focused on this company:.

The Status Box in the lower left hand
corner keeps you informed of the following
vital statistics: the weelk number, your status,
your net worth, the amount of cash you have
on hand, and the interest (on margin and cash
loans) you were charged in the previous week.
Net worth requires some explanation. If is
calculated as follows:
1.Your cash on hand,
2.Plus the value of your stocks and options,

3. Minus margin accounts and cash loans,

4.Minus potential sales commission costs at
present prices,

5.Minus a 30% tax on the gross profit made on
all stocks and options at current prices. (In the
case of a gross loss, a 30% tax credit will be
added.)

The third window is entitled This Week at
a Glance. It appears whenever you enter a
session or select "Extended” from the "Week”
menu. It's purpose is to present you with vital
information on the stock marlket in general
and on your specific holdings. Within it are two
buttons: "Confinue” and "Cancel!’ Select
"Continue” to proceed to the next window of
information; "Cancel” to escape from "The
Week at a Glance’

1



Stock Market Graph

& File News Portfolio Graph Desc Buy/Sell Week Help N

ﬁ The Week at a Glance

Stock Market Graph
3| Ex(ON -

Bendi
Looud

WEEK 15
Novice

Net

Worth $10,000
Cash $10,000
Interest $0

Information will be presented to you in the Computer Industry Graph

following order:
1.The Stock Market Graph (shown above)

appears first. It is a graph of the overall stock Cancel The Week at a Glance @m, e
markef to the present. The horizontal axis of

Computer Industry Graph

the graph is in weeks, and the vertical axis is
the sum of the 15 stocks traded in Millionaire. 2z
An upward trend indicates that on the whole, e
stocks are increasing in value. 16
2.0ne of the five Industry Graphs appears T i
next (shown right). The industry trend is a D 110 Loty
more precise indicator of a specific stock’s %o !
movement, as it charts only 3 corporations. 104 !
The horizontal axis is in weeks, and the verti- :2§
cal axis is the sum of the three stocks in the g8
industry group. For example, shown here is a L BN BN NEN WS W NN S SR S
graph of the Computer Industry. The Computer WEEKS

Industry in Millionaire consists of Control

Data, Apple Computer, and NCR.



3.The Financial Journal (shown below)
appears next. If confains the most important
clues in Millionaire. Study it carefully. News
ifems can signal upward price movements,
downward price movements, or may be
inconclusive. Stock changes are tied fo these
news ifems.

The Financial Journal

The Week at a Glance Enjntli'ue

The Financial Journal

Week 15
Control Data management plead quilty to foreign
bribery

Exxon reported that copper mine revenues are flat

Conoco changed the name of 1ts midwestern
service stations

Apple Computer watchers report Apple |l has
staying power in changing market

Auto Industry inventories are reported down this
quarter

the end

4.Individual Graphs of the corporations in
which you hold stocks or options appear
next. The horizontal axis is in weeks, and the
vertical axis is the dollar value of the specific
stock. (If you don't own any stocks or options,
no graphs will appear.)

5.Lastly, the weekly Stock Changes chart
(shown above right) will appear. This is
similar to picking up the daily paper to see
whaf happened fto your stock. The Stock
Changes Chart lists the following information
on each corporafion: the corporation name,
the stock’s highest and lowest selling price

Stock Changes Chart
The week at a Glance Eonlliue
=——— Stock Changes =
Corporation: High Low Close : Change
Control Data 45.20 36.60 43.92 -1.27
Apple Computer 38.16 33.36 36.56 -1.59
NCR 36 .40 31.08 33.00 -0.75
Conoco 47 44 36.00 46.36 -0.71
Exxon 49.72 39.68 49 .72 % +040
Mabil Oil 50.04 35.84 46 .48 +1.76
Kmart 41.60 31.60 41.60% +2.08
Sears 41.28 25.40 41.28% +0.00
Tandy 42.20 28.52 42.20% +2.60
General Motors 41.84 30.20 41.84% +1.56
American Motors 34.96 27.08 29.68 +0.00
Bendix 47.20 31.08 47 20% +2.00
United States Steel 57.48 40 .48 57.48% +3.48
Dow Chemical 64.04 39.32 64 .04 * +0.44
Caterpillar Tractor 55.16 39.32 95.16% +1.28
There were 9 winners and 4 losers this week.
I Market gained 11 points. An average share gained $0.74.

during the current session, the stock’s current

closing price, and how much the stock price

changed from the previous week. A minus sign

in the "Change” column means the stock has 13
fallen. An asterisk (*) next to the closing price

indicates a new high or low for that stock.

At the bottom of the chart is an analysis
of the week's changes. This analysis consists
of the number of stocks that have increased
in price, the number of stocks that have
decreased in price, the total stock markef
change (sum of the 15 changes), and the
average price change per share.

Next, you will see a window entitled Get-
ting Started. It appears whenever you begin a
new session or select "Getting Started” from the
"Help"” menu. It presents you with a brief sum-
mary of the various options available to you in
Millionaire. A window entitled "Miscellaneous
Notes" also contains information that will aid
you in playing Millionaire. Select “"Notes” from
the "Help” menu fo access if.
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Now, you are ready to begin play. All of
the undimmed menu options are available to
you. Experiment by selecting different options
and manipulating the windows that will appear
on the deskfop. A wealth of information lies af
your fingertips. You may wish to wait a few
“weeks" before making a purchase so that you
may observe the condition of the market.

WHEELING AND DEALING

A favorable news tidbit in The Financial
Journal has led you to consider purchasing
Apply Computer stock. Select the Apple Com-
puter logo from the chart of corporate logos.

Before you commit your hard earned
dollars to Apple, you'd like to know some
information about the company. Select "Apple
Computer” from the "Desc” menu. A text de-
scription of Apple Computer (shown below)
appears on the desktop.

Apple Computer Description

[ [=——=— Apple Computer

Steve Wozniak's design for a personal computer
was rejected by his employer, Hewlett-Packard.
Steve Jobs took interest in Wozniak's design and
sold his VW bus to get the money needed for parts.
Their first computers, based on Wozniak's design
and produced in Job's empty garage, led to Apple
Computer, Inc., the only company ever to become a
member of the Fortune 500 within 5 years of its
incorporation. Today, more than 15,000 programs
are available for computers made by Apple. Apple
is @ member of the computer industry group.

You decide to examine Apple’s perfor-
mance in the stock market during the previous
weeks. Select "Apple Computer” from the
“"Graph” menu. The Macintosh places the Apple
Computer graph atop the previous window,
like papers on a desk.

Next, you wish to investigate how the
computer industry is doing in general. Select
“"Computer Industry” from the "Graph” menu.
This graph appears atop the other two. The
Macintosh allows you to view up to four of
these windows at one time. After that, you
must close a window before calling up another
one. (See "Manipulating Windows" for
instructions on closing a window.)

Affer analyzing all the above information,
you decide to purchase Apple Computer stock.
Select "Buy Apple Computer” from the "Buy/
Sell” menu. (Note that "Stock” has a check
mark next to it. If you were buying Apple
Computer put options, you would first select
"Put Option” from the "Buy/Sell” menu, and
then select "Buy Apple Computer.”)

The Buy Common Stock dialog box
appears on fop of the chart of corporate logos.
(If you are unfamiliar with dialog boxes, see
"Communicating with the Macintosh!) In it,
you will see the Apple logo. The Macintosh asks
you to enter the number of shares you wish to
buy and shows you the maximum number
you can afford to buy. You enter 100" and click
on the "OK" button.

A buy fransaction report appears. It pro-
vides you with a detailed explanation of the
charges incurred in purchasing the stock. Net
Cost is your out-of-pocket cost for the stock.

Congratulations! You now own 100 shares
of Apple Computer.



PROCEEDING TO THE NEXT WEEK

Once you have made all your decisions
for a particular week, you will want to advance
to the next week. Select either "Extended” or
"Quick” from the "Week" menu. Extended
mode displays the following as explained in
"Trading Beqins’:
1.The overall Stock Market graph to date.

2.A graph of one of the 5 industry groups.

3.The Financial Journal for the new week.

4.Individual graphs of the companies in which
you have holdings.

5.The Stock Changes chart for the new week.

Quick mode updates only the windows
already on the screen. Thus, if you have left The
Financial Journal on the desktop, you will see
the latest new messages. Quick mode is used
to advance the game rapidly when you are
cerfain you will nof be making any buy or sell
decisions in that week. Quick mode is primarily
a tool for advanced Millionaire players.

EXAMINING YOUR STOCK PORTFOLIO

To display your stock portfolio, select
"Stocks” from the "Portfolio” menu. The portfolio
appears on the desktop as shown above right.
It consists of the following information for each
company in which you own stock:

Qty in Shares—the number of shares you own.

Purchase Price —the price of the stock when
you purchased it. If you have purchased the
stock over several weeks, the average purchase
price will be shown.

Current Price —the current price of the stock on
this week's marlket.

Percent Equity —the percentage of the stock
you own. The balance is in borrowed funds.

If you purchase stocks on margin, your equity
will be less than 100%. If your equity drops
below 30%, your margin account will be called.

Stock Portfolio

EDE Common Stocks EE
EQ“‘ in |Purchase: Current :Percent: Current
Corporation Shares: Price Price : Equity :Position
Apple Computer 100 $36.56 : $36.56 :100.0%8 +0
0

Current Position—the difference befween the

gross purchase price and the current value of

the stock. This does not take info account

margin, faxes, or commission. A posifive value

means your stock is worth more now than 15
when you purchased it.

(Note: You may only display portfolios in which
you have holdings.)

DOING YOUR HOMEWORK

The key to success in Millionaire is correctly
analyzing information available to you in order
to anticipate —and take advantage of —
changes in the market. The more research you
do before making a trade, the better your
results are likely to be. In Millionaire, you have
a wealth of sources at your command via the
menu bar. Any graph, chart, corporate descrip-
tion, or news item may be called upon at any
time by selecting it from the appropriate menu.
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In addition, The Financial Journal may be
“scrolled” backwards fo research news items
from previous weelks (shown below). To do so,
place the arrow in the right hand column above
the small white box, and click the mouse
button. The whifte box will move up, and news
of the previous week will appear. You may
continue this process back to the 14th week. ..
until the white box is af the very top of the
column. To return to the present, click beneath
the white box, and continue this procedure until
the white box is af the bottom of the column.

Scrolling through News Messages

{ECJI=——— The Financial Journal
North Sea oil rig disaster.
Week 19

United States Steel had record trading volume
today.

Bendix revenues decreased 3%.

General Motors income increased 1%.

Sears had unusual trading activity today.

Mobil 0il experienced surprisingly high volume in
today's market.

Week 20
American Motors revenues increased 5&.

Dow Chemical revenues increased 13.5%. {}
)

The column is called a scroll bar; the small
whife box is called the scroll box. The position
of the scroll box within the scroll bar indicates
which portion of the news messages you are
viewing. You can drag the scroll box to quickly
view another portion of news messages.
(Dragging is a term that refers to pressing the
mouse button and holding it while moving the
mouse.) If you wish to see the first news
message, drag the scroll box to the top of the

scroll bar; fo see the last news message, drag
the scroll box fo the bottom of the scroll bar.

Within the scroll bar there are also two
arrows, one poinfing up and one pointing
down. To scroll line-by-line through the news
messages, click on the arrow that points in the
direction of what you wish fo see. You can also
scroll continuously line-by-line by clicking on
one of the arrows and holding down the mouse
button.

Select "Stock & Option Prices” from the
"News" menu to look at the current prices of
options. This fable consists of the current stock
prices, the current option prices, and the current
option striking prices. In Millionaire, the striking
price of a call option is $5.00 above the current
stock price, and the striking price of a put
option is $5.00 below the current stock price.
An option will expire 26 weeks from the weelk
of purchase.

BUYING ON MARGIN

After you have achieved Investor status,
you may purchase stocks on margin. This
means that you may borrow money from
your broker in order to achieve greater lev-
erage, thus controlling more shares of a stock.

You choose the margin percentage in the
Buy Common Stock dialog box (shown above
right). The default is to purchase af 50%
margin. You may select 0% to 50% margin by
moving the arrow to the percentage you wish
and clicking the mouse button. Buying af 20%
nmargin means you are paying 80% of the price
ouf of your cash, and the broker is loaning you
the other 20%.

Once you have purchased on margin, an
inferest payment will be deducted each week.
The amount of interest deducted in the previous
week will appear in the status box af the
bottom leff hand corner of the deskftop. Re-
member, the lower the margin, the smaller
your interest payments will be (and the less
leverage you will have).



Buy Stock Dialog Box Buy Option Dialog Box
Buy Bu
y
Common [Sears]| can
Stock A
Option
Enter number of
shares :
(467 |:]] Enter number of
mas
Margin lots : [:

O 0% QO30%
Q10% O40 %
O20% ®50%

8K Cancel

BUYING OPTIONS

The procedure for buying options is similar
to that for buying stocks. Select the logo of the
company you wish to buy. Select "Call Option”
or "Put Option” from the "Buy/Sell” menu. Pull
the "Buy/Sell” menu down again. The check
mark will be next to your choice. Select "Buy”
(the menu will say, for example, "Buy Control
Data”) from the "Buy/Sell” menu.

The Buy Options dialog box will appear
(shown above right). Note that you cannot buy
options on margin. Enfer the number of options
you wish fo buy (in quantities of 100, called
lots, or contracts). Select "OK!" A buy trans-
acfion report will appear.

To display an option porffolio, select "Call
Options” or "Put Options” from the "Portfolio”
menu. The portfolio will appear on the desktop.
It will contain the following information for
each company in which you own this type of
option:

Qty in Lots—the numbers of lots you own.

Exp. Week—the weel in which the option
expires.

Strike Price —the striking price of the option.

(120 man)
BK

Stock Price —the current price of the optioned
stock.

Option Value —the current stock option value.

Current Position —the difference between the

gross purchase price and the present value of 17
the option. This does not take info account

margin, faxes, or commission. A posifive value

means your options are worth more now than

when you purchased them.

There are fwo points fo remember about
options. First, the price of an option drops as
the expiration dafe approaches. It is not unusual
fo have a stock price increase moderately and
have the option price drop, due to the passage
of time. Time is of the essence. Second, when
the stock price crosses the striking price, money
is made more rapidly, as every dollar of stock
price change is reflected in the option price.

SELLING STOCKS AND OPTIONS

The procedures for selling stocks and op-
tions are identical. Select the logo of the
company you wish to sell. Select “Stock." "Call
Option;” or "Put Option” from the “Buy/Sell”
menu. Select "Sell” from the "Buy/Sell” menu.



18

A Sell dialog box will appear. Enter the number
of shares or lots you wish to sell. (You do not
have to sell all of a parficular company’s shares
or lots at one time.) Select "OK’

A sell fransaction report will appear. It
provides you with a detailed explanation of
the resulfs of the sale. Cash Received is just that,
the cash you received from the sale. Net Profit
(Loss) takes into account the effects of taxes,
commissions, and margin on the sale. If you
lost money on the sale, you will receive a tax
credit; if you came out ahead, you will be
charged tax on the money you made.

There is one exception fo this simple pro-
cedure. It occurs if you own two or more
different options of the same type for the same
company. When you go fo sell one of these
options, you must indicafte which one you wish
to sell. This is easily accomplished and is ex-
plained in the example below.

EXAMPLE: One week, you purchase Sears
call options with a striking price of $50. Two
weeks later you purchase Sears call options
with a striking price of $52. The two options
have different expiration dates.

Now you wish fo sell one of these options.
You select “Sell Sears” from the “"Buy/Sell” menu.
The Sell Option dialog box appears as usual.

In addition, another window appears on the
desktop. This window lists the two different
options owned for Sears. Move the arrow to
the option you wish to sell and click the mouse
button. The option will now be highlighted.
Click in the Sell dialog box to malke it the acfive
window. Enfer the number of lofs you wish fo
sell and select "OK.” A sell transaction report
will appear as explained above.

LOANS AND INTEREST CHARGES

If your status is Broker, you may borrow
money to purchase stocks and options. Select
“"Loan"” from the “Buy/Sell” menu. The Loan
dialog box will appear. Enter the amount you
wish to borrow and select "OK!" A loan trans-
acfion report will appear.

You may borrow up to 80% of your net
worth; your total loans may not exceed
$500,000 (excluding margin accounts). Inferest
charges on loans are deducted from your cash
on a weekly basis. The annual interest on loans
is 18%. Interest charges can seriously erode
your available cash.

To repay all or part of a loan, select "Repay
Loan” from the "Buy/Sell” menu. The Repay
dialog box will appear. Enter the amount you
wish fo repay and select "OK!" A loan trans-
action reportf will appear. Future interest charges
will reflect the reduction in your loan.

GAME STRATEGY

A few helpful hinfs are now in order fo aid
you in achieving Millionaire status:

1. Keep a note pad and pencil handy as you
play. You may want fo jot down significant
news items and stock trends for future ref-
erence. You may also enfer your notes on
the screen by using the nofe pad accessory
in the Apple menu.

2. Stock options offer the greatest potential for
rapid profits (and losses). Keep track of
expiration dates; options decrease in value
with time.

3. Malke sure fo keep enough cash on hand fo
cover inferest charges and possible margin
calls.



CALLING FOR HELP

At any time, you may ask Millionaire for
help in the form of information.

From the HELP menu, you may view the
Getting Starfed window, the stock reference
window (industry group chart), the status
reference chart, and the Notfes window.

CALLING IT QUITS

At the conclusion of 91 weeks, Millionaire
will automatically liquidate your holdings, and
refain your rank, current net worth, and high
score for future sessions. You will be returned fto
the player directory screen.

If you wish to exit in mid-session, select
"Quit Game” or "Save Game” from the “File”
menu. If you select "Save Game!’ the current
session and environment will be refained, along
with your portfolios, net worth, efc. If you select
"Quit Game," Millionaire will liquidate your
holdings, and retain your rank, current net
worth, and high score in exactly the same
manner as it does af the end of a session.

To exit Millionaire, select "Quit Millionaire”
from the “File” menu on the player directory
screen. After a moment, the Macintosh will
eject the Millionaire disk.
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GLOSSARY OF TERMS

Bear market

When investors believe the stock

market will fall. One who is “bearish” on the
stock market believes in selling shares at the
current time. (Page 4)

Broker

A licensed individual who represents a buyer
or seller of stocks in a fransaction. He receives
a commission for his services.

Bull market

When investors believe the stock market will
rise. One who is "bullish” on the stock market
believes in buying shares at the current time.
(Page 4)

Call option

The right to buy stock in a corporation for a
specified price before a specified fime.
(Pages 4, 5,17)

Commission

The fee paid to a broker for finding a buyer or
seller for a tfransaction, and executing the
purchase or sale. In Millionaire, the commission
is1.5%.

Earnings
The profits of a corporation. (Page 4)

Industry group

Corporations in competition with one another
to sell a particular product or service. In
Millionaire, 3 corporations form an industry
group. (Pages 3, 12)

Insider trading

Buying or selling by “insiders, corporafion
personnel who presumably have knowledge
not yet available to the public. Frequently
referred to in the Financial Journal. (Page 3)

Institutional investor

An organization whose primary purpose is fo

invest its own assets or those held in frust

by if for others. Examples include pension fund
insurance companies, investment companies,
mutual funds, universities, and banks.

Investor
One who buys stocks or options.

Leverage

The use of speculative tools to control more
shares of stock than one could by purchasing
the shares outright. (Page 5)

Long-term investor

An investor whose primary goal is not short-
term gain but steady growth of capital. The
long-term investor generally takes fewer risks.
(Page 3)

Loser
A stock whose price went down during a
given week.

Lot
Unit of 100 shares of stock.



Margin call

When the shareholder’s equity in a stock drops
below a previously agreed upon amount (in
Millionaire, 30%), he must sell his holdings in
order to restore his other shares to the mini-
mum level of equity, unless cash is available
to cover the margin call. (Page 4)

Net worth

The value of an individual's cash, plus securities,

minus pofential commissions, taxes, and
inferest. (Pages 6, 11)

Odd lot
A unit less than 100 shares of stock.

Portfolio
Listing of stocks or options that an investor
owns. (Page 6)

Put option

The right fo sell stock in a corporation for a
specified price before a specified fime.
(Pages 4, 5,17)

Selling short

A speculative technique used when an investor
believes the price of a stock is about fo drop
dramatically. The investor borrows shares (for
a fee) from a broker, sells them, and banks the
proceeds. When the stock drops in price, he
buys the shares back and returns the shares to
the loaning broker. The difference between
the fwo prices is his profit. (Page 5)

Shareholder
One who owns stock in a corporation.
(Page 3)

Short-term investor
A person who holds their stocks for less than
one year. (see Speculator)

Speculator

One who is willing to take large risks in order
to achieve significant profits over the short-
term. (Pages 3, 4, 5)

Stock
Part ownership of a corporation, expressed in
shares. (Page 3)

Stock exchange

A place where stocks and options are bought
and sold. The most prominent stock exchange
in America is the New York Stock Exchange,
where stocks of the largest corporafions are
traded.

Striking price
The stocls price at which an investor may buy or
sell an option, and make a profit. (Pages 5, 17)

Trend

A sequence of events giving evidence of a
direction. A stock that rises for several weeks
exhibits an upward frend. (Pages 4, 12)

Volume

The number of shares of stock sold during a
given week. "Heavy volume” means that many
shares were fraded.

Winner
A stock whose shares went up in price during
a given week.
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IMPORTANT: READ THIS CAREFULLY

The Warranty Registration Card included
with all programs must be sent in within
10 days after your purchase to validate
the warranty.

In the event that the diskette should fail to
operate within ninety days of purchase, return
it to Blue Chip Software for free replacement.
You must include proof of purchase. If the
diskette fails to operate after the 90-day
period, there will be a five dollar replacement
charge.

Drawings by Mei-Ying Chen, courtesy of T-Maker.
All logos are the registered trademarks of their
respective companies.



USER REGISTRATION
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